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Introduction 

Congratulations on purchasing Cyrillic Support 2000, a complete set of software 
and fonts for using Cyrillic in Windows. 

What Cyrillic Support 2000 Does 

Cyrillic Support 2000 includes everything you need to use Cyrillic-based 
languages in Windows Web browsers, e-mail programs, word processors, 
and other applications. It supports all modern Slavic languages which use a 
Cyrillic alphabet: Belarusian, Bulgarian, Macedonian, Russian, Serbian, and 
Ukrainian. 

In addition to supporting the standard Russian alphabet, Cyrillic Support 
2000 also lets you use accented Russian vowels for marking stress. This 
feature is described in more detail in “Marking Russian Stress” (page 10). 

Cyrillic Support 2000 Programs 

Cyrillic Support 2000 provides you with four useful programs. 

You will use Cyrillic Keyboard or Russian Keyboard on a regular basis. 
They provide a flexible way to type Cyrillic in virtually any Windows 
program. Features include hot keys for easy switching between English and 
Cyrillic keyboard layouts, both standard and phonetic Cyrillic layouts, and 
easy customization of any pre-defined keyboard layout. These programs are 
discussed in “Typing in Cyrillic” (page 9) and following sections. 

Cyrillic Setup lets you modify the configuration of your Windows system so 
that you can use Cyrillic in menus, dialog boxes, and other contexts where 
you cannot select a font. It is described in “Running Cyrillic Setup” (page 
5). 

Character Set Converter can convert Cyrillic text between a variety of 
popular Cyrillic character sets. It is described in “Converting Cyrillic Text” 
(page 17). 
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Cyrillic Support 2000 Fonts 

Cyrillic Support 2000 includes two Cyrillic typefaces which are suitable for 
longer texts. Couriere is available in a plain style, while Timesse supports 
plain, italic, bold styles. 

Couriere æèçíü 
Timesse  æèçíü 
Timesse Italic  æèçíü 
Timesse Bold  æèçíü 

 
Cyrillic Support 2000 also includes a set of eight decorative Cyrillic fonts: 

Artisan Cyr æèçíü 
Brush Stroke Cyr  æèçíü 
Graceful Script Cyr  æèçíü 
Kids Hand Cyr  æèçíü 
Mechanical Pencil Cyr  æèçíü 
Mechanical Pencil Wide Cyr  æèçíü 
Old Cyrillic Cyr  æèçíü 
Showtime Cyr  æèçíü 

 
About this User’s Guide 

This User’s Guide is designed to help you get up to speed quickly with 
Cyrillic Support 2000. It covers installation and basic usage instructions, but 
more advanced topics and features are left for the online help. Once you 
become comfortable with the material in this User’s Guide, feel free to 
explore the online help of each program included with Cyrillic Support 
2000. Online help is accessed by clicking the “Help” menus or buttons 
available throughout the programs.  
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Installing Cyrillic Support 2000 

Cyrillic Support 2000 takes just a few minutes to install. Installation is normally 
very straightforward, but if you should encounter any problems, please feel free 
to contact us at (210) 659-2532 or support@cyrillic.com for assistance. 

Starting Installation 

For best results, you should shutdown and restart your computer 
immediately before installing Cyrillic Support 2000. After the computer has 
restarted, insert your installation CD. If an installation menu opens, choose 
“Install Cyrillic Support 2000” and skip to “A Fresh Installation” (page 4). 

If no installation menu opens, click the Start button, then choose Run… 

 

Enter d:\install.exe and click OK (if your CD-ROM is not drive d:, then 
change “d” to the appropriate drive letter). 

 

When the installation menu opens, choose “Install Cyrillic Support 2000.” 

mailto:support@cyrillic.com
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A Fresh Installation 

If Cyrillic Support has never been installed on this computer, you will see a 
dialog box asking whether the default directory is acceptable. 

 

If the suggested directory is acceptable, simply click Begin to start the 
installation process. Otherwise you can type a different directory or click 
Browse to choose a directory before clicking Begin. 

Replacing a Previous Installation 

If you have previously installed any version of Cyrillic Support on this 
computer, the installation program will request permission before 
overwriting it. 

 

In almost all cases, you should click Begin to replace the previous 
installation. 

If you have made any changes via the Cyrillic Setup program, it will be 
necessary to undo these changes and reboot your computer before 
continuing with installation. A dialog box will list the necessary steps. 
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After following these directions, you should return to “Starting Installation” 
(p. 3) and repeat the installation process. 

Running Cyrillic Setup 

After installation, you will be given an opportunity to run Cyrillic Setup, one 
of the programs included with Cyrillic Support 2000. 

 

Cyrillic Setup allows you to modify the configuration of your Windows 
system so that you can use the Cyrillic alphabet in menus, dialog boxes, and 
other contexts where you cannot select a font. You can run this program at 
any time to change your configuration, but most users just run it once after 
installation and have no further need to modify their configuration. 

If you use only English and Cyrillic-based languages, click OK to start 
Cyrillic Setup. But if you need to use Latin-based languages other than 
English in your menus and dialog boxes (e.g., French, German, Spanish, 
etc.), then you probably should not make any changes with Cyrillic Setup. 
Just click Cancel at the above dialog, and your installation will be complete. 
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For additional information on the options presented in this dialog box, click 
the small question mark “?” in the upper right corner of the window, then 
click the option you wish to know more about. 

Your first choice is whether to use the standard Cyrillic character set (called 
Code Page 1251), or an academic Russian variant. The standard character 
set is fine for most users, but if you need to mark stress in Russian words 
you should choose “Russian only (includes accented vowels).” Please see 
“Appendix A: Cyrillic vs. Academic Russian” (page 28) for further details. 
These character sets are detailed in Appendix B (page 29). 

Under “Use Cyrillic Versions of these Fonts” most users should check all 
three boxes. 

The “Advanced Settings” section is only appropriate for users who are 
having difficulty running software created in Russia. If you cannot read the 
menus, dialog boxes, or other information in such a program, you may wish 
to try checking these boxes. 

After changing any settings in Cyrillic Setup, you should click OK to save 
your new configuration. In most cases you will need to restart your 
computer before your new settings take effect. 

Cyrillic Support 2000 is now fully installed. Before using it, please read 
“Installing Windows Multilanguage Support” (page 7) and follow the 
instructions appropriate for your version of Windows.
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Installing Windows Multilanguage Support 

In order to conveniently use Cyrillic in many newer Windows applications, you 
may need to perform an additional installation procedure. This procedure adds 
optional Windows system files that support Cyrillic languages. Please follow the 
steps described below for your version of Windows. If you are not sure which 
version of Windows you are running, click the “Start” button and the menu 
which pops up will identify your Windows version. 

Windows 95/98/Me 

1. Click “Start” then “Settings” then “Control Panel.” 
2. Open the “Add/Remove Programs” icon. 
3. In the dialog which opens, click the middle tab, “Windows Setup.” 
4. Beneath “Components” scroll down to “Multilanguage Support.”  
5. If you see a check mark beside “Multilanguage Support,” then no 

further steps are necessary. Simply click the Cancel button and 
close Control Panel. 

6. If you see a blank box beside “Multilanguage Support,” click this 
box to place a check mark in it, then click OK. 

7. Windows will copy some system files; insert your Windows CD if 
requested to do so. 

8. When all files have been copied, Windows will inform you that a 
reboot is necessary. Click “Yes” to allow the reboot to occur. 

 
Windows 95 Note: If you have an early copy of Windows 95, you may not 
see “Multilanguage Support” in the list of components (step 4). In this case, 
you need to download Multilanguage Support from Microsoft’s Web site at: 

http://www.microsoft.com/downloads 

This will bring you to a search page. Do a keyword search for 
“multilanguage support” with Operating System set to “Windows 95.” Click 
on “Windows 95 Update CD-ROM Extras: Multilanguage Support.” You 
should reach another page with a long list of files. The file you want to 
download is called Lang.exe. You should download it to a blank directory, 
then run it. You can run it by opening the “My Computer” icon on the 
desktop, browsing to the directory where it was downloaded, and double 
clicking lang.exe. After it runs, you’ll see a readme file which describes the 
rest of the installation process. 

 

http://www.microsoft.com/downloads/
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Windows NT/XP 

Windows NT and XP include all necessary system files by default; no
additional installation steps are necessary. 

Windows 2000 

1. Click “Start” then “Settings” then “Control Panel.” 
2. Open the “Regional Options” icon. 
3. In the dialog which opens, click the left tab, “General.” 
4. Beneath “Language settings for the system” scroll down to 

“Cyrillic.”  
5. If you see a check mark beside “Cyrillic,” then no further steps are 

necessary. Simply click the Cancel button and close Control Panel. 
6. If you see a blank box beside “Cyrillic,” click this box to place a 

check mark in it, then click OK. 
7. Windows will copy some system files; insert your Windows CD if 

requested to do so. 
8. When all files have been copied, Windows will inform you that a 

reboot is necessary. Click “Yes” to allow the  reboot to occur.
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Using Cyrillic in a Word Processor 

The following sections present a tutorial on basic word processing in Cyrillic. 
Additional information is available in the online help of Cyrillic Keyboard, 
Russian Keyboard, and Character Set Converter. 

Typing in Cyrillic 

1. Start Cyrillic Keyboard  by clicking “Start,” “Programs,” “Cyrillic 
Support 2000,” “Cyrillic Keyboard.” You should see a keyboard 
diagram. If you are instead greeted with the following message, 
please read “Installing Windows Multilanguage Support” (page 7). 

 

 
 

2. Select a Cyrillic keyboard layout from the “Keyboard” menu of 
Cyrillic Keyboard. Note that multiple layouts are available for 
Russian and Ukrainian. 
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3. Start your word processor and select a Cyrillic font such as 
“Timesse Cyr.” Most word processors offer a toolbar for selecting 
a font, as well as a “Font” command on a “Format” or “Text” menu. 

 

 
 

4. Begin typing. You should see Cyrillic letters which correspond to 
the keyboard layout you have chosen. To type English again, 
simply select one of the English layouts from the Keyboard menu 
of Cyrillic Keyboard. Note that you do not need to change fonts 
when switching between English and Cyrillic; modern Cyrillic fonts 
contain the full English alphabet. 

 
Typing Third Symbols 

You will notice that most of the keyboard layouts provided in Cyrillic 
Keyboard  and Russian Keyboard  show an extra character in the bottom 
right corner of certain keys. These extra characters are normally displayed in 
blue, and they can be typed by pressing the key while holding down the 
right Alt key. For examp le, in most keyboard layouts, you can type the Euro 
symbol (ˆ ) by holding down right Alt and pressing the “E” key. 

Marking Russian Stress 

As an aid to students, Russian teachers often mark stress in Russian words 
by placing accent marks over the vowels of stressed syllables. Similarly, 
some Bulgarian users use this feature to type Bulgarian i-grave (Œ). The 
following instructions will explain how to type accented Cyrillic vowels. If 
you do not not need this feature, you can skip this section. 

1. Start Russian Keyboard  by clicking “Start,” “Programs,” “Cyrillic 
Support 2000,” “Russian Keyboard.” You should see a keyboard 
diagram. 

2. Select a Russian keyboard layout from the “Keyboard” menu of 
Russian Keyboard, and make sure “Academic Russian (CP 1251)” 
is checked near the bottom of this menu. 
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3. Start your word processor, and select either “Couriere Russ” or 
“Timesse Russ.” These are the only two fonts you can use for 
typing accented Cyrillic vowels. 

4. Accented vowels are normally typed by means of a dead key. 
When you press a dead key, no character is inserted into your 
document, but the keyboard enters a special mode whereby the 
next vowel you type is accented. For example, if you select the 
Russian (phonetic) keyboard layout, you will notice that the key 
beside Right Shift has an acute dead key as its third symbol. Hold 
down your right Alt key and press this key. The keyboard diagram 
is updated. 

 

 
 

5. Now press any key which contains a vowel, and you will get an 
accented form of that vowel. If you hold down Shift as you type the 
vowel, you’ll get a capital accented vowel. After typing one letter, 
your keyboard reverts to its normal state. When you wish to type 
another accented vowel, you will need to press the dead key again 
before typing the vowel. 
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6. The instructions above demonstrated how to type an acute accent, 
which is normally used to mark primary stress. Some users also like 
to mark secondary stress by means of a grave accent. On the 
Russian (Phonetic) layout, the key in the upper left corner of the 
keyboard contains the grave dead key as its third symbol. Hold 
down your right Alt key and press this key. 

 

 
 

7. The next vowel you type will receive a grave accent, indicating 
secondary stress. Notice that no capital letters are shown; grave 
accents are provided for lower case vowels only. 

 
Switching Keyboard Layouts with Hot Keys 

If you start Cyrillic Keyboard  or Russian Keyboard, and press both Shift 
keys at the same time, your keyboard layout will switch between U.S. 
English and Russian (Phonetic). This “hot key” approach is a convenient 
alternative to switching keyboard layouts via the “Keyboard” menu. 

The only hot key that is initially active is Shift+Shift, which switches 
between U.S. English and Russian (Phonetic). You can easily add other hot 
keys using the following steps. 

1. Choose “Hot keys…” from the “Options” menu of Cyrillic 
Keyboard  or Russian Keyboard. 

2. Beneath “For this keyboard layout” choose the layout for which 
you wish to add or remove a hot key. 

3. Beneath “Use this hot key” choose the hot key you wish to assign 
to this keyboard layout. If you choose “None” (located first in the 
list), then this keyboard layout may only be selected via the 
Keyboard menu. This is appropriate for keyboard layouts you 
seldom or never use. 
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4. Repeat steps (2) and (3) until you have the hot keys assigned as you 
like, then click OK to close this dialog. Keep in mind that you can 
assign the same hot key to several keyboard layouts, as was 
initially done with Shift+Shift. 

 

 
 

You should now try pressing the hot keys you just assigned to be sure they 
work properly. If you click the “Keyboard” menu, you should see your new 
hot keys beside the keyboard layouts to which they have been assigned. 

Choosing a Cyrillic Character Set 

Toward the bottom of the “Keyboard” menus for Cyrillic Keyboard and 
Russian Keyboard you will notice a set of three character set choices. 
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Unicode 
Unicode is a new character encoding standard which can support nearly all 
the world’s languages. It has become the preferred standard for encoding 
Cyrillic text in most modern word processors and other application 
programs under Windows 95, 98, Me, NT 4, 2000, and XP. You should use 
Unicode for any Cyrillic documents which you plan to exchange with others 
electronically. Unicode is also normally required if you will be using add-on 
spelling or grammar checkers, dictionaries, or translation aids for Cyrillic-
based languages. 

Unicode is initially selected when you start Cyrillic Keyboard or Russian 
Keyboard. While typing with Unicode, you may use any of the fonts 
provided with Cyrillic Support 2000 that end in “Cyr” or “Russ” (e.g., 
Timesse Cyr or Couriere Russ). 

Code Page 1251 
Code Page 1251 is the Cyrillic standard used in Windows 3.1. This has 
three uses in Cyrillic Support 2000. First, if you need to type accented 
Cyrillic vowels (see page 10), then you must select a font ending in “Russ” 
(e.g., Couriere Russ or Timesse Russ), use the Russian Keyboard program, 
and set the character set to “Academic Russian (CP 1251).” Another 
important use for Code Page 1251 is to type with older Cyrillic fonts which 
were designed for Windows 3.1. If you set the character set to “Unicode” 
with such older fonts, all you see is square boxes. If this occurs, try typing 
with Code Page 1251 instead. A final use is to type Cyrillic in programs that 
cannot handle Unicode, such as certain e-mail or drawing programs, or 
Windows Notepad on certain versions of Windows. 

Internet Cyrillic (KOI8) 
KOI8 is mainly used for Cyrillic communication on the Internet. When 
typing with this character set, you must select one of the fonts that end in 
“KOI8” (e.g., Timesse KOI8 or Couriere KOI8). This is required when you 
wish to use Cyrillic in certain e-mail programs such as America Online; for 
details, see “Using Cyrillic in E-mail” (page 19). 

Selecting Other Cyrillic Fonts 

The Cyrillic fonts which have been discussed most often in this User’s 
Guide are Couriere and Timesse. These are basic text fonts which come with 
Cyrillic Support 2000 and support the widest range of Cyrillic character 
sets. 

Cyrillic Support 2000 also includes a set of eight decorative Cyrillic fonts: 
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Artisan Cyr æèçíü 
Brush Stroke Cyr  æèçíü 
Graceful Script Cyr  æèçíü 
Kids Hand Cyr  æèçíü 
Mechanical Pencil Cyr  æèçíü 
Mechanical Pencil Wide Cyr  æèçíü 
Old Cyrillic Cyr  æèçíü 
Showtime Cyr  æèçíü 

 
As with all Cyrillic Support 2000 fonts ending in “Cyr,” you can type these 
fonts with either Cyrillic Keyboard or Russian Keyboard, and you can use 
either Unicode or Code Page 1251 as your character set (see page 13). 

A number of Unicode Cyrillic fonts are available from various sources. 
These can be typed with either Cyrillic Keyboard or Russian Keyboard, 
with Unicode selected as your character set. If you have installed Windows 
Multilanguage Support (see page 7), your system will have Unicode 
versions of Arial, Courier New, and Times New Roman. 

Several other Unicode fonts are included with newer versions of Internet 
Explorer, Office, Windows, and other Microsoft products. A partial list 
includes: Arial Black, Arial Euro, Arial Narrow, Book Antiqua, Bookman 
Old Style, Century Gothic, Comic Sans MS, Garamond, Haettenschweiler, 
Impact, Lucida Console, Lucida Sans Unicode, Monotype Corsiva, Tahoma, 
and Verdana. 

Hiding the Keyboard Window 

If you have a keyboard which is labeled for Cyrillic, or if you have 
memorized the layout of Cyrillic letters, you may prefer to hide the 
keyboard diagram while using Cyrillic Keyboard or Russian Keyboard. To 
do so, click the minimize button, which is the leftmost of the three buttons 
shown in the upper right corner of the window. 

 

It is important that you minimize the window rather than close it. If you 
close the window by clicking the rightmost button, the keyboard program 
becomes inactive. With the window minimized, the keyboard remains 
active; the keyboard diagram is simply hidden from view. 
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When the window has been minimized, you will still see a small key icon in 
your Taskbar, near the clock. 

 

The icon will indicate which language is associated with the active keyboard 
layout; in this case it is Russian. If you wish to see the keyboard diagram 
again, simply double click this icon. 

While the keyboard diagram is hidden, you can still switch your keyboard 
layout using a hot key (see page 12). If you click the icon with your left 
mouse button, the “Keyboard” menu will pop up. You can use this menu to 
switch your keyboard layout or character set, or to exit the program. 

 

Starting the Keyboard Automatically 

If you type in Cyrillic frequently, you may wish to have the keyboard 
program start automatically each time you start Windows. To do this, start 
either Cyrillic Keyboard or Russian Keyboard, whichever one you normally 
use, and choose “Startup Preferences” from the “Options” menu. 
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Check the “Auto-load” box if you want the keyboard program to start 
automatically for you. This dialog also lets you choose which keyboard 
layout and character set are initially active when the program starts, where 
the keyboard diagram is placed on screen, and whether to start with the 
window minimized. 

Converting Cyrillic Text 

Character Set Converter, one of the programs included with Cyrillic 
Support 2000, allows you to convert Cyrillic text between a variety of 
popular character sets. Although this program is not normally used as 
regularly as the other programs in Cyrillic Support 2000, a brief 
introduction will be presented here for those who might need to convert 
Cyrillic text. Please refer to the online help for Character Set Converter for 
a more complete set of instructions. 

As a sample situation for using Character Set Converter, assume you have 
typed a Russian document using stress marking (see page 10 for information 
on how to do this). Now assume you need to convert the document to 
Unicode, perhaps to run it through a spell checker, or to send it to a 
colleague who does not have the Academic Russian fonts from Cyrillic 
Support 2000. The following steps will accomplish this. 

1. Open your word processor, highlight the entire document, and 
choose “Copy” from the “Edit” menu to copy it to the clipboard. 

2. Start Character Set Converter and fill out the dialog as shown. 
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3. Click Begin to convert the clipboard text to Unicode. This removes 
accents from the Russian vowels, as Unicode has no provision for 
marking Russian stress. 

4. Return to your word processor, start a blank document, and choose 
“Paste” from the “Edit” menu to paste the Unicode text in. 

5. Save this new document under a different name. 
 

Other situations where you might wish to use Character Set Converter 
include converting documents between KOI8 (Internet Cyrillic) and one of 
the Windows character sets (Unicode or Code Page 1251), or converting 
documents between Macintosh and Windows character sets. 

Please keep in mind that Character Set Converter does not preserve 
formatting when it converts text. All boldface, indentation, etc. will be 
removed, so you will need to reformat the converted document. 
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Using Cyrillic on the Internet 

Cyrillic Support 2000 will enable you to use Cyrillic in most e-mail programs 
and Web browsers. The first two sections below present general information on 
using Cyrillic in e-mail and Web browsing, and the following sections offer 
details pertaining to several popular applications. Please note that the online help 
of Cyrillic Keyboard and Russian Keyboard cover several additional 
applications; please consult it if your e-mail program or Web browser is not 
discussed below. 
 
Using Cyrillic in E-mail 

For most Cyrillic-based languages, the KOI8 character set is used in e-mail. 
Bulgarian is an exception, as many Bulgarian users send e-mail in Code 
Page 1251. To communicate properly, you and your correspondents need to 
use the same character set. For more details on Cyrillic character sets, see 
“Choosing a Cyrillic Character Set” (page 13) and “Appendix B: Character 
Set Charts” (page 29). 

As you read the application notes on using Cyrillic in e-mail, you will find 
that e-mail programs take one of two basic approaches to supporting KOI8. 
With some newer programs, such as Netscape Communicator (page 20) and 
Outlook Express (page 22), you type in Windows Cyrillic and they convert 
your note to KOI8 before it is sent. Other programs such as AOL (page 23) 
and Eudora (page 26) don’t know how to convert Cyrillic character sets, so 
you must type your message directly in KOI8. 

Using Cyrillic in Web Browsers 

To correctly display a Cyrillic Web page, your browser must use fonts of the 
appropriate character set. Most Cyrillic Web sites present their pages in 
Code Page 1251 by default, with an option to use KOI8 instead. 

Many Cyrillic Web pages automatically tell browsers which character set to 
use, but in some cases you will need to select a character set manually. As a 
general rule, whenever you encounter a Cyrillic Web page that is 
unreadable, first try telling your browser to display it in Code Page 1251, 
and if it remains unreadable, try KOI8. 

It is relatively easy to setup modern Web browsers to switch between Code 
Page 1251 and KOI8; this is described below for Netscape Communicator 
(page 20) and Internet Explorer (page 22). 
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Netscape Communicator 4.x or Later 

Initial Setup 
The following steps need to be done only once. 

1. Choose “Preferences” from the Edit menu, and select Fonts 
(beneath “Appearance”). 

2. Beside “For the Encoding,” choose “Cyrillic.” 
3. Select Timesse Cyr and Couriere Cyr as your variable width and 

fixed width Cyrillic fonts. 
4. Check the box “Use my default fonts, overriding document-

specified fonts.” (This step is optional, but it will help you more 
easily read certain Cyrillic Web sites.) 

5. Click OK to dismiss the dialog. 
 

Note that step 3 is optional if you have installed Windows Multilanguage 
Support (see page 7 for instructions). 

If Russian is the only Cyrillic-based language you use, then your initial 
setup is complete. If you use other languages, especially Ukrainian, and 
need KOI8 support, you should repeat steps 1 through 5 above, but in step 2 
choose “User Defined” instead of “Cyrillic.” Then, in step 3, select Timesse 
KOI8 and Couriere KOI8 as your variable width and fixed width fonts. 

If you need to use Code Page 1251 in e-mail, as is common for Bulgarian, 
you should repeat steps 1 through 5 above, but in step 2 choose “User 
Defined” instead of “Cyrillic.” Follow steps 3-5 as shown. 

Composing Cyrillic E-mail 
If you have not already done so, please read “Using Cyrillic in E-mail” 
(page 19). 

Netscape Communicator requires you to compose e-mail in Windows 
Cyrillic (CP 1251), then it automatically converts your messages to KOI8 
before sending. The following approaches will let you properly send mail in 
various character sets: 

• To send a message in KOI8-R (Russian or Bulgarian only). Before 
composing the message, open Communicator’s View menu, and set 
“Character Set” to “Cyrillic (Windows-1251).” (In some versions of 
Communicator, you will see “Encoding” instead of “Character Set.”) 
You should also use the Keyboard menu of Cyrillic Keyboard or 
Russian Keyboard to select “Unicode,” “Windows Cyrillic (CP 1251),” 
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or “Academic Russian (CP 1251).” Before sending your message, 
Communicator will automatically convert it to KOI8-R. 

• To send a message in KOI8 (Ukrainian and other languages). First, 
make sure you have set your User Defined fonts to Timesse KOI8 and 
Couriere KOI8 as described near the end of the “Initial Setup” section 
above. Then, before composing the message, open Communicator’s 
View menu, and set “Character Set” to “User-Defined.” (In some 
versions of Communicator, you will see “Encoding” instead of 
“Character Set.”) You should also use the Keyboard menu of Cyrillic 
Keyboard or Russian Keyboard to select “Internet Cyrillic (KOI8).” 

• To send a message in Windows Cyrillic (Code Page 1251). First, 
make sure you have set your User Defined fonts to Timesse Cyr and 
Couriere Cyr as described at the end of the “Initial Setup” section above. 
Then, before composing the message, open Communicator’s View 
menu, and set “Character Set” to “User-Defined.” (In some versions of 
Communicator, you will see “Encoding” instead of “Character Set.”) 
You should also use the Keyboard menu of Cyrillic Keyboard or 
Russian Keyboard to select “Unicode,” “Windows Cyrillic (CP 1251),” 
or “Academic Russian (CP 1251).” 

Cyrillic Web Browsing 
If you have not already done so, please read “Using Cyrillic in Web 
Browsers,” (page 19). 

While browing, if you encounter a Cyrillic Web page that is unreadable, 
open Communicator’s View menu, and set “Character Set” to “Cyrillic 
(Windows-1251).” (In some versions of Communicator, you will see 
“Encoding” instead of “Character Set.”) If the page is still unreadable, try 
setting “Character Set” to “Cyrillic (KOI8-R).” If the Web page uses a 
Cyrillic language other than Bulgarian or Russian, then some of the letters 
may still be unreadable. In this case, make sure you have set your User-
Defined fonts to Timesse KOI8 and Couriere KOI8 as described near the 
end of the “Initial Setup” section above, and set “Character Set” to “User-
Defined.” You may have to change the character set as you move from site 
to site. 
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Internet Explorer 4.x or Later 

Initial Setup 
The following steps need to be done only once. 

1. You must install Windows Multilanguage Support (see page 7) 
before you can conveniently use Cyrillic in Internet Explorer. 

2. Choose “Internet Options” from the “Tools” menu, click the 
General tab, and click the “Accessibility” button. Click “Ignore 
font styles specified on Web pages” and click OK. (This step is 
optional, but it will help you more easily read certain Cyrillic Web 
sites.) 

3. Click OK to dismiss the dialog. 
 

Cyrillic Web Browsing 
If you have not already done so, please read “Using Cyrillic in Web 
Browsers,” (page 19). 

If you encounter a Cyrillic Web page that is unreadable, open Internet 
Explorer’s View menu, click “Encoding,” then “Cyrillic (Windows).” (In 
some versions of Internet Explorer, you will see “Fonts” instead of 
“Encoding.”) If the page still does not display correctly, open the View 
menu again and set “Encoding” to “Cyrillic (KOI8-R)” (for Russian) or 
“Cyrillic (KOI8-U)” (for Ukrainian). You may need to change this encoding 
setting as you move from site to site. 

Outlook Express 5 

Initial Setup 
You must install Multilanguage Support (see page 7) before you can 
conveniently use Cyrillic in Microsoft Outlook Express. 

Composing Cyrillic E-mail 
If you have not already done so, please read “Using Cyrillic in E-mail” 
(page 19). 

While composing a Cyrillic e-mail message, click Outlook’s Format menu, 
and choose “Plain Text” (as opposed to “Rich Text”). Now click the Format 
menu again, and set “Encoding” to “Cyrillic (KOI8-R)” (for Russian), 
“Cyrillic (KOI8-U)” (for Ukrainian), or “Cyrillic (Windows)” (used mostly 
for Bulgarian). You should also use the Keyboard menu of Cyrillic 
Keyboard or Russian Keyboard to make sure you are typing with Unicode, 
regardless of which character set you have selected in Microsoft Outlook 
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Express 5. (The message will automatically be converted to KOI8-R, KOI8-
U, or Code Page 1251 before it is sent.) 

Outlook 2000 or Later

Initial Setup 
The following steps need to be done only once. 

1. You must install Multilanguage Support (see page 7) before you 
can conveniently use Cyrillic in Microsoft Outlook 2000 or later. 

2. Choose “Options” from the Tools menu, and click the Mail Format 
tab. 

3. Beside “Send in this message format” choose “Plain Text.” 
4. Uncheck the box labeled “Use Microsoft Word to edit e-mail 

messages.” 
5. Click OK to dismiss the dialog. 

 
Composing Cyrillic E-mail 
If you have not already done so, please read “Using Cyrillic in E-mail” 
(page 19). 

While composing a Cyrillic e-mail message, click Outlook’s Format menu, 
and choose “Plain Text” (as opposed to “Rich Text”). Now click the Format 
menu again, and set “Encoding” to “Cyrillic (KOI8-R)” (for Russian), 
“Cyrillic (KOI8-U)” (for Ukrainian), or “Cyrillic (Windows)” (used mostly 
for Bulgarian). You should also use the Keyboard menu of Cyrillic 
Keyboard or Russian Keyboard to make sure you are typing with Unicode, 
regardless of which character set you have selected in Microsoft Outlook. 
(The message will automatically be converted to KOI8-R, KOI8-U, or 
Code Page 1251 before it is sent.) 

AOL 5.0 or Later 

Composing Cyrillic E-mail 
If you have not already done so, please read “Using Cyrillic in E-mail” 
(page 19). 

 

While composing a KOI8 e-mail message, select the font Couriere KOI8 or 
Timesse KOI8. You should also use the Keyboard menu of Cyrillic 
Keyboard or Russian Keyboard to make sure you are typing with Internet 
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Cyrillic (KOI8). If you wish to compose an e-mail message using Windows 
Cyrillic (Code Page 1251), you should instead select the font Couriere Cyr 
or Timesse Cyr, and use the Keyboard menu to make sure you are typing 
with “Windows Cyrillic (CP 1251)” or “Academic Russian (CP 1251).” 

Instead of setting the font each time you compose an e-mail message, you 
may find it more convenient to tell AOL to use a Cyrillic font by default. To 
do this, click the “My AOL” (AOL 5.0) or “Settings” (AOL 6.0) button in 
AOL’s toolbar, and choose “Preferences” from the menu which opens. Now 
click the “Font” button, and choose either “Couriere KOI8” or “Timesse 
KOI8” if you use KOI8 for e-mail, or “Couriere Cyr” or “Timesse Cyr” if 
you use Code Page 1251 for e-mail. The font you select here will be used by 
default in the future. 

In order to read incoming Cyrillic messages, it may be necessary to highlight 
the entire message with your mouse, click the Reply button, highlight the 
entire message again, and then select a Cyrillic font such as Couriere KOI8 
or Couriere Cyr. 

Cyrillic Web Browsing 
If you have not already done so, please read “Using Cyrillic in Web 
Browsers,” (page 19). 

You will need to install Windows Multilanguage Support (see page 7) 
before you can browse Cyrillic Web sites. If you encounter a Cyrillic Web 
page that is unreadable, right-click on a blank area of the Web page, and 
from the menu which pops up choose Encoding, then “Cyrillic (Windows).” 
If the page is still unreadable, right-click again, and this time choose 
Encoding, then “Cyrillic (KOI8-R)” or “Cyrillic (KOI8-U).” You may have 
to change this encoding setting as you move from site to site. 

CompuServe 2000 

Composing Cyrillic E-mail  
If you have not already done so, please read “Using Cyrillic in E-mail” 
(page 19). 

While composing a KOI8 e-mail message, select the font Couriere KOI8 or 
Timesse KOI8. You should also use the Keyboard menu of Cyrillic 
Keyboard or Russian Keyboard to make sure you are typing with Internet 
Cyrillic (KOI8). If you wish to compose an e-mail message using Windows 
Cyrillic (Code Page 1251), you should instead select the font Couriere Cyr 
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or Timesse Cyr, and use the Keyboard menu to make sure you are typing 
with “Windows Cyrillic (CP 1251)” or “Academic Russian (CP 1251).” 

In order to read incoming Cyrillic messages, it may be necessary to highlight 
the entire message with your mouse, click the Reply button, highlight the 
entire message again, and then select a Cyrillic font such as Couriere KOI8 
or Couriere Cyr. 

Cyrillic Web Browsing 
If you have not already done so, please read “Using Cyrillic in Web 
Browsers,” (page 19). 

You will need to install Windows Multilanguage Support (see page 7) 
before you can browse Cyrillic Web sites. If you encounter a Cyrillic Web 
page that is unreadable, right-click on a blank area of the Web page, and 
from the menu which pops up choose Encoding, then “Cyrillic (Windows).” 
If the page is still unreadable, right-click again, and this time choose 
Encoding, then “Cyrillic (KOI8-R)” or “Cyrillic (KOI8-U).” You may have 
to change this encoding setting as you move from site to site. 

Using Cyrillic in Forum Messages 
Please note that for the method outlined here to work, you and your 
correspondents must be using CompuServe 2000 on a Windows machine, 
and you must have Windows Multilanguage Support installed (see page 7). 

To compose a message, use the Keyboard menu of Cyrillic Keyboard or 
Russian Keyboard to make sure you are typing with Unicode. You will be 
able to type Cyrillic in the body of the forum message. 

To read a forum message written in Cyrillic, right-click on a blank area of 
the forum message, and from the menu which pops up choose Language, 
then “Cyrillic Alphabet (Windows).” This is analogous to the procedure 
given above for Web browsing. 
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Eudora 4.3 or Later 

Initial Setup 
To set up Eudora for Cyrillic, take the following steps: 

1. Choose “Options” from the Tools menu. 
2. Beneath “Category,” choose the icon labeled “Fonts” (you may 

have to scroll down to find this icon). 
3. In the “Message” box, set “Proportional:” to Timesse KOI8 and 

“Fixed-width:” to Couriere KOI8. 
4. In the “Printer” box, set “Font:” to Timesse KOI8. 
5. In the “Screen” box, set “Font:” to Timesse KOI8. 
6. Beneath “Category,” choose the icon labeled “Viewing Mail” (it is 

normally below the “Fonts” icon). 
7. In the “Message Window” box, uncheck the option for “Use 

Microsoft’s viewer.” 
8. Click OK to dismiss the dialog. 
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Note: If you need to use the Windows Cyrillic character set (CP 1251), as is 
often done for Bulgarian, simply select Timesse Cyr and Couriere Cyr as 
you follow the above steps. 

Using Cyrillic in E-mail 
If you have not already done so, please read “Using Cyrillic in E-mail” 
(page 19). 

Once you complete the Initial Setup steps, you will be able to use Cyrillic in 
e-mail. When creating a message, use the Keyboard menu of Cyrillic 
Keyboard or Russian Keyboard to be sure you are typing with the 
appropriate character set. This is normally Internet Cyrillic (KOI8), but 
many Bulgarian users work in Windows Cyrillic (CP 1251).
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Appendix A: Cyrillic vs. Academic Russian 

Cyrillic Support 2000 offers two separate keyboard programs and two sets of 
text fonts. This section will help you decide which is appropriate for your needs. 

Cyrillic 

Cyrillic Keyboard and fonts with a suffix of “Cyr” (e.g., Timesse Cyr) support 
six Cyrillic-based languages: Belarusian, Bulgarian, Macedonian, Russian, 
Serbian, and Ukrainian. This program and font set support two Cyrillic character 
sets: Unicode, and Code Page 1251 (for a chart see Appendix B, page 29). 

You must use Cyrillic Keyboard and select one of the “Cyr” fonts whenever you 
are working in Belarusian, Macedonian, Serbian, or Ukrainian. 

Academic Russian 

Russian Keyboard and fonts with a suffix of “Russ” (e.g., Timesse Russ) support 
only Russian and Bulgarian. Accented forms of the Russian vowels are included 
to let you mark stress, as is commonly done by Russian teachers. This program 
and font set support two Cyrillic character sets: Unicode, and an academic 
variant of Code Page 1251 (for a chart see Appendix B, page 29). 

You must use Russian Keyboard and select one of the “Russ” fonts in order to 
mark stress in Russian words. For more information on marking Russian stress, 
see “Marking Russian Stress” (page 10). Some Bulgarian users prefer this 
arrangement as well in order to type Bulgarian i-grave (Œ). 

When Either Will Do 

If Russian is the only Cyrillic-based language you use, and you don’t need to 
mark stress in Russian words, you can use either Cyrillic Keyboard or Russian 
Keyboard and any of the fonts provided with Cyrillic Support 2000. Most users 
in this situation go with Cyrillic Keyboard. 

If you normally use Russian Keyboard, note that you can still select any of the 
“Cyr” fonts whenever you are working in the Unicode character set. This lets 
you conveniently access the decorative fonts included with Cyrillic Support 
2000 without having to switch keyboard programs.
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Appendix B: Character Set Charts 
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Note: Position 152 is unused. 
 
Windows Cyrillic, Code Page 1251 (Russian-only) 
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KOI8 (Internet Cyrillic) 
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Note: This variant of KOI8 was designed by Fingertip Software; it is a superset 
of the popular variants KOI8-R (Russian) and KOI8-U (Ukrainian). 
 
Code Page 1252 (Western) 
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Note: Positions 129, 141, 143-144, and 157 are unused. 
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Appendix C: Troubleshooting 

This appendix discusses several common questions that come up while using 
Cyrillic Support 2000. If you are unable to resolve a problem after reading this 
appendix, feel free to contact Fingertip Software for technical support at 210-
659-2532 or support@cyrillic.com. 

Why You Can't Type Cyrillic in Some Places 
If you have selected a Cyrillic keyboard layout, but still cannot type Cyrillic, 
check the following: 

• If the program you are using allows you to select a font, make sure your 
current font matches the Cyrillic character set you are typing with. For 
details, see “Choosing a Cyrillic Character Set” (page 13). 

• Some programs do not allow font selection, e.g., Windows Notepad 
under Windows 95 or the menus and dialog boxes of most programs. To 
use Cyrillic in such places, you need to run Cyrillic Setup and replace 
your system fonts with Cyrillic counterparts. For details, see “Running 
Cyrillic Setup” (page 5). 

• E-mail programs and Web browsers take a different approach to font 
selection; see “Using Cyrillic on the Internet” (page 19) for details. 

Why Your Third Symbols May Not Work 
If you have a notebook computer which contains only a single Alt key, then 
you cannot use the default “Right Alt” key to type third symbols. If you are 
using Windows NT, 2000, or XP, you should choose “Third symbol key”
from the “Options” menu of Cyrillic Keyboard or Russian Keyboard, and
select “Either Alt.” Under Windows 95, 98, or Me, you will need to use
Ctrl+Left Alt to type third symbols (hold both Ctrl and Left Alt down while
typing a key containing a Third symbol). 

For general instructions on typing third symbols, see “Typing Third 
Symbols” (page 10). 

Why the Cyrillic Key Caps Font May Fail to Load 
Cyrillic Keyboard and Russian Keyboard use a Key Caps font when 
drawing their keyboard display. If this font cannot be loaded properly when 
you start one of these programs, you’ll see an error message. 

mailto:support@cyrillic.com
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The following situations can lead to this message: 

• The font file may be missing or damaged. Try re-installing Cyrillic 
Support 2000. 

• You may have too many fonts installed in Windows. Windows 95, 98, 
and Me have an upper limit of 500 to 1,000 installed fonts, depending on 
factors such as how much memory you have and what other programs 
and drivers are active. When you reach this limit, no additional fonts can 
be loaded by programs like Cyrillic Keyboard or Russian Keyboard. Try 
starting Control Panel (click Start, then Settings, then Control Panel), 
opening the “Fonts” icon, and deleting 10 or more of the installed fonts. 

Why You May Be Unable to Update the Registry 
While running on Windows NT, 2000, or XP, Cyrillic Keyboard and Russian 
Keyboard need to update a certain system key in the registry. If you are on a 
network or a shared standalone computer and haven’t been granted 
sufficient permission to do this, you will receive an error message. 

 

If you encounter this message, you should click Help, print the topic which 
is displayed, and give the printout to your network administrator. 
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Please note that until your network administrator makes the required 
changes, you will not be able to type with the Unicode character set; you’ll 
have to use Code Page 1251 or KOI8 instead. For general information on 
character sets, see “Choosing a Cyrillic Character Set” (page 13). 
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Appendix D: Uninstalling Cyrillic Support 2000 

Cyrillic Support 2000 includes an automated uninstall program which you can 
run at any time to remove the product from your system. 

For best results, you should shutdown and restart your computer immediately 
before uninstalling Cyrillic Support 2000. Once the computer has restarted, click 
the Start button, then Programs, then Cyrillic Support 2000, then the icon labeled 
“Uninstall Cyrillic Support 2000.” You will be greeted with a dialog box 
requesting confirmation. 

 

Click Yes to uninstall. If you have made any changes via Cyrillic Setup, the 
uninstall program will require you to undo these changes before continuing. This 
is similar to the installation procedure described under “Replacing a Previous 
Installation” (page 4). 
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Appendix E: License Agreement and Warranty 

Grant of license. Under this license you may:  
 

• Use Cyrillic Support 2000 (the “software”) on only one machine at a 
time, unless an agreement with Fingertip Software, Inc. (“Fingertip”) 
specifies otherwise 

• Copy the software for backup 
• Transfer possession of the software to another party 

 
Copyright. The software is licensed to you by Fingertip and is protected by 
United States copyright laws and international treaty provisions. Therefore, you 
must treat the software like any other copyrighted material. 
 
Restrictions. You may not rent or lease the software, but you may transfer the 
software on a permanent basis provided you retain no copies and the recipient 
agrees to the terms of this Agreement. If the software is an update, any transfer 
must include the update and all prior versions. 
 
Limited warranty. Fingertip warrants that the software will perform 
substantially in accordance with the accompanying printed and online 
documentation, and that any diskettes or printed documentation supplied will be 
free from defects for a period of ninety (90) days from the original purchase 
date. 
 
Customer remedies. Fingertip’s entire liability and your exclusive remedy shall 
be, at Fingertip’s option, either a) refund of the price paid or b) repair or 
replacement of the software that does not meet Fingertip’s Limited Warranty. 
Refunds shall require that any disks and printed documentation received be 
returned to Fingertip with a copy of your receipt or other proof of purchase. This 
Limited Warranty is void if failure of the software has resulted from accident, 
abuse, or misapplication. 
 
No other warranties. Fingertip disclaims all other warranties, either express or 
implied, including but not limited to implied warranties of merchantability and 
fitness for a particular purpose, with respect to the software and the 
accompanying printed and online documentation. This limited warranty gives 
you specific legal rights. You may have other rights which vary from state to 
state or country to country. 
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No liability for consequential damages. In no event shall Fingertip or its 
suppliers be liable for any damages whatsoever (including but not limited to, 
damages for loss of business profit, business interruption, loss of business 
information, or other pecuniary loss) arising out of the use or inability to use this 
product, even if Fingertip has been advised of the possibility of such damages. 
Because some states and countries do not allow the exclusion or limitation of 
liability for consequential or incidental damages, the above limitation may not 
apply to you. 
 
This agreement is governed by the laws of the State of Texas. 
 
Fingertip Software, Inc., P.O. Box 2487, Universal City, TX 78148, USA, (210) 
659-6832. 
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